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DISCLAIMER 

Ministry of Agriculture through the Consultant and core reviewers from all relevant stakeholders included the 

information to provide the contemporary approach about the subject matter. The information contained in the 

guidelines is obtained from sources believed tested and reliable and are augmented based on practical 

experiences. While it is believed that the guideline is enriched with professional advice, for it to be 

successful, needs services of competent professionals from all respective disciplines. It is believed, the 

guidelines presented herein are sound and to the expected standard. However, we hereby disclaim any 

liability, loss or risk taken by individuals, groups, or organization who does not act on the information 

contained herein as appropriate to the specific SSI site condition.  

mailto:SSIDdirectorate@moa.gov.et
mailto:SSIDdirectorate@gmail.com
http://172.28.1.188:8080/DMS/login.jsp
http://www.moa.gov.et/
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FORWARD 

Ministry of Agriculture, based on the national strategic directions is striving to meet its commitments in 
which modernizing agriculture is on top of its highest priorities to sustain the rapid, broad-based and 
fair economic growth and development of the country.  To date, major efforts have been made to 
remodel several important strategies and national guidelines by its major programs and projects. 
 
While efforts have been made to create access to irrigation water and promoting sustainable irrigation 
development, several barriers are still hindering the implementation process and the performance of 
the schemes. The major technical constrains starts from poor planning and identification, study, design, 
construction, operation, and maintenance. One of the main reasons behind this outstanding challenge, 
in addition to the capacity limitations, is that SSIPs have been studied and designed using many ad-
hoc procedures and technical guidelines developed by various local and international institutions. 
  
Despite having several guidelines and manuals developed by different entities such as MoA (IDD)-
1986, ESRDF-1997, MoWIE-2002 and JICA/OIDA-2014, still the irrigation professionals follow their 
own public sources and expertise to fill some important gaps. A number of disparities, constraints and 
outstanding issues in the study and design procedures, criteria and assumptions have been causing 
huge variations in all vital aspects of SSI study, design and implementation from region to region and 
among professionals within the same region and institutions due mainly to the lack of agreed standard 
technical guidelines. Hence, the SSI Directorate with AGP financial support, led by Generation 
consultant (GIRDC) and with active involvement of national and regional stakeholders and international 
development partners, these new and comprehensive national guidelines have been developed. 
 
The SSID guidelines have been developed by addressing all key features in a comprehensive and 
participatory manner at all levels. The guidelines are believed to be responsive to the prevalent study 
and design contentious issues; and efforts have been made to make the guidelines simple, flexible and 
adaptable to almost all regional contexts including concerned partner institution interests. The outlines 
of the guidelines cover all aspects of irrigation development including project initiation, planning, 
organizations, site identification and prioritization, feasibility studies and detail designs, contract 
administration and management, scheme operation, maintenance and management. 
 
Enforceability, standardization, social and environmental safeguard mechanisms are well 
mainstreamed in the guidelines, hence they shall be used as a guiding framework for engineers and 
other experts engaged in all SSI development phases. The views and actual procedures of all relevant 
diverse government bodies, research and higher learning institutions, private companies and 
development partners has been immensely and thoroughly considered to ensure that all 
stakeholders are aligned and can work together towards a common goal. Appropriately, the guidelines 
will be familiarized to the entire stakeholders working in the irrigation development.  Besides, significant 
number of experts in the corresponding subject matter will be effectively trained nationwide; and the 
guidelines will be tested practically on actual new and developing projects for due consideration of 
possible improvement.  Hence, hereinafter, all involved stakeholders including government & non-
governmental organizations, development partners, enterprises, institutions, consultants and 
individuals in Ethiopia have to adhere to these comprehensive national guidelines in all cases and at all 
level whilst if any overlooked components are found, it should be documented and communicated to 
MOA to bring them up-to-date.  
 
Therefore, I congratulate all parties involved in the success of this effort, and urge partners and 
stakeholders to show a similar level of engagement in the implementation and stick to the guidelines 
over the coming years. 
 

 
 
H.E. Dr. Kaba Urgessa 
State Minister, Ministry of Agriculture                                                                          
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SMALL SCALE IRRIGATION DEVELOPMENT VISION 

  
Transforming agricultural production from its dependence on rain-fed practices by creating reliable irrigation 

system in which smallholder farmers have access to at least one option of water source to increase 

production and productivity as well as enhance resilience to climate change and thereby ensure  food 

security, maintain increasing  income and sustain economic growth. 
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PREFACE 

While irrigation development is at the top of the government’s priority agendas as it is key to boost 

production and improve food security as well as to provide inputs for industrial development. 

Accordingly, irrigated land in different scales has been aggressively expanding from time to time. 

To this end, to enhance quality delivery of small-scale irrigation development planning, 

implementation and management, it has been decided to develop standard SSI guidelines that 

must be nationally applied. In September 2017 the Ministry of Agriculture (MoA) had entrusted 

Generation Integrated Rural Development Consultant (GIRDC) to prepare the National Small-

scale Irrigation Development Guidelines (SSIGLs). 

 
Preparation of the SSIGLs for enhancing development of irrigated agriculture is recognized as one 

of the many core initiatives of the MoA to improve its delivery system and achieve the targets in 

irrigated agriculture and fulfill its mission for improving agricultural productivity and production. The 

core objective of developing SSIGLs is to summarize present thinking, knowledge and practices to 

enable irrigation practitioners to properly plan, implement and manage community managed SSI 

schemes to develop the full irrigation potential in a sustainable manner.  

 

As the SSIGLs are prepared based on national and international knowledge, experiences and 

practices, and describe current and recommended practice and set out the national standard 

guides and procedures for SSI development, they serve as a source of information and provide 

guidance. Hence, it is believed that the SSIGLs will contribute to ensuring the quality and timely 

delivery, operation and maintenance of SSI schemes in the country. The SSIGLs attempt to 

explain and illustrate the important concepts, considerations and procedures in SSI planning, 

implementation and management; and shall be used as a guiding framework for professionals 

engaged in SSI development. Illustrative examples from within the country have been added to 

enable the users understand the contents, methodologies presented in the SSIGLs. 

 

The intended audiences of the SSIGLs are government organizations, NGOs, CSOs and the 

private sector involved in SSI development. Professionally, the SSIGLs will be beneficial for 

experienced and junior planners, experts, contractors, consultants, suppliers, investors, operators 

and managers of SSI schemes. The SSIGLs will also serve as a useful reference for academia 

and researchers involved and interested in SSI development. The SSIGLs will guide to ensure 

that; planning, implementation and management of SSI projects is formalized and set procedures 

and processes to be followed. As the SSIGLs provide information and guides they must be always 

fully considered and applied by adapting them to the local specific requirements.  

 

In cognizance with the need for quality SSIGLs, the MoA has duly considered quality assurance 

and control during preparation of the guidelines. Accordingly, the outlines, contents and scope of 

the SSIGLs were thoroughly discussed, reviewed and modified by NAWMP members (senior 

professionals from public, national and international stakeholder) with key stakeholders in many 

consultative meetings and workshops. Moreover, at each milestone of SSIGL preparation, 

resource persons from all stakeholders reviewed and confirmed that SSIGLs have met the 

demands and expectations of users. 

 
Moreover, the Ministry has mobilized resource persons from key Federal, National Regional States 

level stakeholders and international development partners for review, validation and endorsement 

of the SSIGLs.   
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Several hundreds of experienced professionals (who are very qualified experts in their respective 

fields) from government institutions, relevant private sector and international development partners 

have significantly contributed to the preparation of the SSIGLs. They have been involved in all 

aspects of the development of SSIGLs throughout the preparation process. The preparation 

process included a number of consultation meetings and workshops: (i) workshop to review  

inception report, (ii) workshop on findings of review of existing guidelines/manuals and proposed 

contents of the SSIGLs, (iii) meetings to review  zero draft SSI GLs, (iv) review workshop on draft 

SSI GLs, (v) small group review meetings on thematic areas, (vi) small group consultation 

meetings on its final presentation of  contents and layout, (vii) consultation mini-workshops in the 

National States on semi-final versions of the SSIGLs, and (viii) final write-shop for the appraisal 

and approval of the final versions of SSIGLs. 

 

The deliberations, concerns, suggestions and comments received from professionals have been 

duly considered and incorporated by the GIRD Consultant in the final SSIGLs.  

 

There are 34 separate guidelines which are categorized into the following five parts concurrent to 

SSI development phases: 

 

Part-I. Project Initiation, Planning and Organization Guideline which deals with key considerations 

and procedures on planning and organization of SSI development projects. 

Part-II. Site Identification and Prioritization Guideline which treats physical potential identification 

and prioritization of investment projects. It presents SSI site selection process and 

prioritization criteria.  

Part-III. Feasibility Study and Detail Design Guidelines for SSID dealing with feasibility study 

 and design concepts, approaches, considerations, requirements and procedures in the 

 study and design of SSI systems. 

Part-IV. Contract Administration and Construction Management Guidelines for SSI development 

presents the considerations, requirements, and procedures involved in construction of 

works,  construction supervision and contract administration.  

Part-V. SSI Scheme Management, Operation and Maintenance Guidelines which covers SSI 

 Scheme management and operation.  

 

Moreover, Tools for Small Scale Irrigation development are also prepared as part of SSIGLs. 

 

It is strongly believed and expected that; the SSIGLs will be quickly applied by all stakeholders 

involved in SSI development and others as appropriate following the dissemination and 

familiarization process of the guidelines in order to ensure efficient, productive and sustainable 

irrigation development. 

 

The SSIGLs are envisioned to be updated by incorporating new technologies and experiences 

including research findings. Therefore, any suggestions, concerns, recommendations and 

comments on the SSIGLs are highly appreciated and welcome for future updates as per the 

attached format below.  Furthermore, despite efforts in making all types of editorial works, there 

may still errors, which similarly shall be handled in future undated versions.   
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UPDATING AND REVISIONS OF GUIDELINES 

The GLs are intended as an up-to-date or a live document enabling revisions, to be updated 

periodically to incorporate improvements, when and where necessary; may be due to evolving 

demands, technological changes and changing policies, and regulatory frameworks. Planning, 

study and design of SSI development interventions is a dynamic process. Advancements in these 

aspects are necessary to cope up with the changing environment and advancing techniques. Also, 

based on observation feedbacks and experiences gained during application and implementation of 

the guidelines, there might be a need to update the requirements, provisions and procedures, as 

appropriate. Besides, day-by-day, water is becoming more and more valuable. Hence, for efficient 

water development, utilization and management will have to be designed, planned and 

constructed with a new set up of mind to keep pace with the changing needs of the time. It may, 

therefore, be necessary to take up the work of further revision of these GLs.  

 

This current version of the GLs has particular reference to the prevailing conditions in Ethiopia and 

reflects the experience gained through activities within the sub-sector during subsequent years. 

This is the first version of the SSI development GLs. This version shall be used as a starting point 

for future update, revision and improvement. Future updating and revisions to the GLs are 

anticipated as part of the process of strengthening the standards for planning, study, design, 

construction, operation and management SSI development in the country. 

 

Completion of the review and updating of the GLs shall be undertaken in close consultation with 

the federal and regional irrigation institutions and other stakeholders in the irrigation sub-sector 

including the contracting and consulting industry. 

 

In summary, significant changes to criteria, procedures or any other relevant issues related to 

technological changes, new policies or revised laws should be incorporated into the GLs from their 

date of effectiveness. Other minor changes that will not significantly affect the whole nature of the 

GLs may be accumulated and made periodically. When changes are made and approved, new 

page(s) incorporating the revision, together with the revision date, will be issued and inserted into 

the relevant GL section. 

 

All suggestions to improve the GLs should be made in accordance with the following procedures: 

 

I. Users of the GLs must register on the MOA website: Website: www.moa.gov.et 

II. Proposed changes should be outlined on the GLs Change Form and forwarded with a 

covering letter or email of its need and purpose to the Ministry. 

III. Agreed changes will be approved by the Ministry on recommendation from the Small-scale 

Irrigation Directorate and/or other responsible government body. 

IV. The release date of the new version will be notified to all registered users and authorities. 

 

Users are kindly requested to present their concerns, suggestions, recommendations and 

comments for future updates including any omissions and/or obvious errors by completing the 

following revisions form and submitting it to the Ministry. The Ministry shall appraise such requests 

for revision and will determine if an update to the guide is justified and necessary; and when such 

updates will be published. Revisions may take the form of replacement or additional pages. Upon 

receipt, revision pages are to be incorporated in the GLs and all superseded pages removed.  

 

http://www.moa.gov.et/
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Suggested Revisions Request Form (Official Letter or Email) 

 

To: --------------------------------------------------------------- 

From: ----------------------------------------------------------- 

Date: ----------------------------------------------------------- 

Description of suggested updates/changes: Include GL code and title, section title and # 

(heading/subheading #), and page #.  

 

GL Code and 
Title 

Date Sections/ 
Heading/Subheading/ 
Pages/Table/Figure 

Explanation  Comments (proposed 
change)  

     

     

Note that be specific and include suggested language if possible and include additional sheets for 

comments, reference materials, charts or graphics.  

 

GLs Change Action 

Suggested Change  Recommended Action Authorized by Date  

    

    

    

Director for SSI Directorate: _______________________Date: ________________ 

 

The following table helps to track initial issuance of the guidelines and subsequent Updates/Versions and 

Revisions (Registration of Amendments/Updates).  

 

Revision Register 

Version/Issue/Revision 
No  

Reference/Revised 
Sections/Pages/topics 

Description of 
revision 
(Comments) 

Authorized 
by  

Date 
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 BACKGROUND 1

Basic software’s like Global Mapper, Google earth, different GIS software’s, DEM are useful in 

planning and site assessment. Global Mapper is the easiest user interface software used for data 

management including organizing, generating contours, layout design, generating & exporting 

profiles, etc.  

 

Engineering and water management software’s incudes   

 Arc GIS and Arc Hydro: This is a very powerful software used for analyzing vector and 
raster images, studying and delineating the catchment area, generating contours and 
profiles, mapping the layout, etc. 

 AutoCAD: This software is used for designing layout, plan and cross sections of 
irrigation infrastructures, generating profiles, etc. 

 Z-profile: this software used for generating profiles for which design was done initially on 
excels. 

 Eagle Point: This software is a powerful tool for generating contours, designing layout of 
irrigation infrastructures, design plan and cross sections of irrigation canals and 
structures, etc.  

 Geoslope/Geo studio is mainly used for stability analysis 

 CLIMWAT 2, LocClim 1.0, CROPWAT 8, are used  in analysis of climate input data and  
water requirement of irrigated crops  

 MS Project and Primavera are used for scheduling and controlling study and design as 
well as construction activities of SSIP 

 Other software’s like SWAT, Water Cad, SAP, SMADA, Hydrochan are also in SSID  

Software’s used in geology, Engineering geology & hydrogeology are: Geo studio (including 

all integrated tools like Slope//w, SEEP/W, SIGMA/W, Quake/W) and other geotechnical 

software’s like Starter, Stero plot. Auto cad is also equally important for the geologists to prepare 

the sections.   

 

Software’s used in Topo surveying are: are AutoCAD, Arc GIS; Global Mapper, Auto Cad, 

Golden Software (Surfer), Stereo net, Strata for data compilation and topo mapping.  

 

Software’s used in Socioeconomics are;   SPSS16 and SPSS 20, STATA  

 

We will discuss here in this specific Guideline selected software’s. The other application software’s 

will be discussed in respective subjects of the Guidelines.  
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 MANUAL FOR EAGLE POINT 2

 BASIC KNOWLEDGE OF EAGLE POINT 2.1

 The eagle point software suite 2.1.1

Eagle Point software is the most powerful, yet easy-to-use, civil engineering, surveying and 

landscape design software’s available. By combining the power of AutoCAD the software employs 

methods identical to conventional methods used in hand calculations. 

 

The software it is not intended to replace the presence of qualified surveyor, designer or drafting 

personnel. Instead, the software enlarges the capabilities of qualified professionals. Therefore; a 

solid working knowledge on the principles of Surveying, Hydrology, Road, Civil and Water 

Engineering expected by the user. 

 Purpose 2.1.2

Eagle Point is application software that is used to aid most of Land Development problem 

including:  

 Watershed Modeling 

 Road Design 

 Storm and Sanitary Sewer Analysis 

 Landscape Design 

 Pressurized Irrigation Design  

 Site Planning, Design and Analysis 

 Intersection Design 

 Quantity takeoff and so on… 

 Scope 2.1.3

This guideline covers the basic procedures for Surface Modeling, Roadcalc for irrigation design 

and Drafting (Case study of Petu SSI Project). 

 Computer requirements 2.1.4

Pentium III with Microsoft, Windows 2000 and above, (recommended: Intel processor with 1GB of 

RAM), 1024x768 display. AUTOCAD software Version 2000-2007 

 CASE STUDY FOR PETU SURFACE MODELING 2.2

 Preparation of working environment 2.2.1

This practical exercise will help how to prepare topographical map using Eagle point surface 

model package for Petu SSIP. 

 Getting started 2.2.2

Defining a project 

 Create project folder anywhere and Name it PETU SSIP 

 Create two folders within it and name them as Data, Plot 
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 Open new AutoCAD file and save it in your project folder as PETU SSIP 

 

 Run the program from start menu and the following dialogue will box popup 

 

 Click on the Create New Project 

 Click next by selecting eagle point project 

 

 In the project description edit box fill it as Petu SSIP 

 In project drawing edit box and click open the previously saved AUTO CAD file 
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 Select Eagle point Meters default from the prototype setting drop list 

 Click on the Advanced tab and select Data and Plot folders for the respective dialogue 

 

 Click finish button and Click ok 

 Eagle point software then launches AutoCAD 

 The Eagle point software menu bar displays as follows 

 

 Project setting 2.2.3

I. Units 

Select units from the system pull down menu to display the unit’s dialog box. Units are going to be 

set for the project are adjusted as follows 

a) Angular 

 Select angular from the category drop list 

 For both input and output make sure that degree, minutes, seconds are selected 

 Clicks Apply and OK 
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b) Degree of curvature 

 Select degree of curvature from the category dropdown list 

 Select Arc definition from the input/output drop list 

 Type 20 in the arc definition from the input /output list 

 Clicks Apply and OK 

 

c) Linear 

 Select linear from the category drop list in the unit’s dialog box 

 

d) Plan metric area 

 Select plan metric Area from the category drop list. 

 Select both input/output and make sure square meters are selected  

 Click Ok to save the changed 
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II. Formats 

Select Formats from the system menu to display the formats dialog box 

a) Stationing 

 Select stationing from the category drop list in the format dialog box 

 Select +000 from the format drop list 

 Clicks Apply and OK 

 

b) Horizontal Direction 

 Select horizontal direction from the category drop list in the format dialog box. 

 Select North Azimuth from the format drop list 

 Clicks Apply and OK 

c) Nodes 

 Select nodes from the category drop list in the formatted dialog box. 

 Select Alpha Numeric from the ID format drop list. 

 Make sure point protection * is toggled on. 

 Clicks Apply and OK 

 

III. Precision 

Select precision from the system menu and keep default values 

a) Angular 

 Select angular from the category drop list 

 Slide decimal slider to 4. 

 Select nearest second form Degree, Minutes, Second drop list 

 Click apply 
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b) Linear 

 Select linear from the category drop list 

 Click apply to accept the default value of 3 decimal places. 

 Select also plan metric area, dry volume, wet volume, station offset consequently and 
apply the default value of 3 decimal places precision respectively. 

 

IV. Scales 

 From the Eagle point menu bar, select tools‐plot scales 

 Type 1000 in the horizontal scale field 

 Type 100 in the vertical scale field 

 Click OK  

 

V. CAD settings 

Eagle point provides a tool whereby you can set default CAD parameters for the majority of 

CAD objects that are constructed by eagle point. 

a) Default CAD settings 

 Select system –Default CAD settings. 

 Highlight the Surface Modeling and then Index Contours entry 

 Type the size and select the color of the line (index contours) you wish to display in 
CAD entry. 

 Type the size and select the color of the line (intermediate contours) you wish to display 
in CAD entry 

 Click on OK  
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 Surface Modeling 2.2.4

Surface modeling is a one of eagle point package that models the surface you are working on by 

performing different manipulation of the raw data from survey, DEM and DTM by creating three 

dimensional grid formations on the terrain. 

Surface Modeling also allows users to create a model from topographical information such as 

points, break lines or contours. From this surface model, you can create contours, annotate 

contours, create rectangular grids and place spot elevations. 

 Setting up a surface model 2.2.5

Creating and defining a new surface model, requires the following procedures  

 In eagle point, select Products‐Surface modeling 

 

 In surface modeling, select prepare‐manage surface models 

 

 

 Click on the new surface model icon then the new surface model dialog box displays  
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 Type Petu ground model in the description edit filed. 

 Minimum elevation from Surveying data is 1355.551 

 Maximum elevation from Surveying data is 1476.524 

 

 Click on the CAD setting icon, the CAD setting dialog box displays. 

 Layer ‐TIN 
 Color - by layer 

 Click Ok 

 Click on apply in the new surface model dialog box and then OK 

 Click Contour setting Tab icon. 
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 Intermediate Interval = 1 

 Index Interval = 5 

 Smoothing Factor = 3 

 Set the remaining values of the setting as: 

 Index contours 
 Layer IDX‐contours 
 Color 9 
 Line type by layer 
 Width 0 

 Intermediate contours 
 Layer contours 
 Color 8 
 Line type by layer 
 Width 0 

 Click on apply in the new surface model dialog box. 

 Keep the rest as default. 

 Click apply and OK 

 Click close 

 Importing Survey Data 2.2.6

 Survey data’s can be imported from an excel file, an instrument, global mapper, GPS, 
etc as eagle point have different option to import the data. For this training purpose, you 
are going to import the survey data from an excel file which is saved in CSV file format.
  

 Open excel (Survey Data.CSV) and view your data down loaded from a total station. 
The survey consists of information with point#, Easting, Northing, Elevation and 
description. 
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 In eagle point, surface modeling‐ select Prepare‐Import ASII‐points 

 Browse the survey file to the location you have saved 

 Click on the open bottom 

 Check the button point#, N, E, description (point code) 

 Click on apply in the import ASCII point dialog box  

 Click on close 

 

 Type Z in the command line then e to view the imported data 
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 Creating model boundary 2.2.7

Draw a boundary around the data and then predefine it for use in the surface model. To create a 

predefined boundary for the surface model, 

 In Auto CAD, create a layer called Boundary line and make it current 

 

 Select the poly line command. 

 Draw the boundary around your data 

 

 In surface modeling, select Prepare‐Predefined boundaries command 
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 Click on the new predefined boundary icon. 

 Pick the boundary object you drew earlier 

 Type Survey Data boundary in the description edit field 

 Select Petu ground model from the surface model drop list 

 Click ok and close 

 

 Triangulate a surface model 2.2.8

 In surface modeling, select triangulate‐surface model  

 Select ground model from the surface model drop list 

 

 Select predefined from the boundary drop list 

 

 Make sure the display selected objects details and Place Triangles are toggled on 

 Click on apply in the triangulate surface model then close 

 Select the area to be triangulated by selecting the bounded data in the CAD graphic 
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 Click Ok display selected objects details to proceed triangulation 

 The result of Triangulation should look like this 

 

 In surface modeling, select Prepare‐Manage surface model. 

 Click on the properties for surface model icon. The surface model properties dialog 
displays a variety of information for the model as follows. 

 Click on close 

 

 Creating contours 2.2.9

 In Surface modeling, on contours tab select Make intermediate and index  
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 Make sure the Petu ground model is selected from the surface model drop list. 

 Toggle on only User defined boundary  

 

 Click on apply on the make intermediate and index contours in the CAD graphic 

 Select the boundary you have prepared earlier 

 Eagle point will execute the process 

 

 The processed contour should look like this 
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 Annotating contours 2.2.10

Contour annotation is a process that is used label each contour and makes the user to easily 

recognize the terrain types in CAD graphic. 

 In surface modeling select Contours‐ Annotate  

 

 Make sure the Petu Ground Model is selected 

 

 Make the index toggle on  

 Select the Interval option in the method sections 

 Interval = 500 

 Click on the Annotation setting button. 

 

 Make sure middle is selected from the annotation drop list. 

 Toggle on Place Symbol Around Annotation 

 Toggle off the other option. 

 Click on OK 

 Click on apply in the annotate contours dialog box. 

 Select the contour to annotate in CAD graphics 
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 Click on close. 

 The result should look like this 

 

 Zoom into the area that was annotated to view the contour elevation. 

 

 

 CANAL PROFILE EXTRACTION FROM IRRIGATION SYSTEM LAYOUT  2.3

In surface Modeling we have modeled the topographical features of the area of our interest (Topo 

of the Gross command area). Canal alignment and other important tasks are worked on the 

surface model as practical implementation of our canal design on the real ground. Precise 

representation of the ground is imperative prior to any design activity. 

 

Designing an irrigation Canal is to be initiated by selecting the centreline of the alignment using the 

surface model created. The RoadCalc package found in Eagle point Product menu will be utilized 

to facilitate canal design.  

 Getting started 2.3.1

Roadcalc is the step to be started after you have successfully prepared the surface model and the 

step to be followed to initiate the launch RoadCalc is as follows. 
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 Creating a roadcalc subproject 2.3.2

 In eagle point Select File‐New 

 Select Roadcalc subproject from the list box 

 

 Click on next 

 Type MC in the project number edit field 

 Type Main Canal Design in the description edit field 

 Select RoadCalc metric defaults from the subproject prototype drop list 

 Click on Next 

 

 Select Petu SSIP from the project list box 

 Click on Finish 

 

 To launch Roadcalc, select the Main Irrigation design project and click OK 
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 The Roadcalc menu displays 

 

 Canal alignment & profile 2.3.3

Eagle point software facilitates to view original ground profiles so that we can export it to excel to 

design Top bank, Full supply and Bed levels of a canal. 

So the design profile of our canal alignment is to be created as allows 

 

 The green line is the main canal route selected during irrigation system layout so we 
start by making alignment using it 

 From Alignment tab select Convert Objects to Alignment 

 

 From the CAD graphics you will be asked to select the object 
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 Left Click on the main canal line and press enter 

 Inquiry box will pop up to establish the direction of the alignment  

 

 Click on the station that is going to be the beginning 0+000 

 

 Keep the default values if it suite you then click Apply 

 

 The green line will change red color indicating the conversion is successful 
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 Go to profile tab and select Extract from Surface Model 

 

 Select centerline for Profile Name & Petu ground model from drop down list, then Ok 

 

 Again you will be asked to select the object in command line of CAD  

 

 

 Left click and RoadCalc will draw the canal Profile  
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 In order to extract X, Y and Elevation values we have to prepare black notepad file so 
the results can be printed on it. To do so 

 Create Notepad file, name it as MC-Profile, Save it in a place which suites you 

 Go to file menu and select Print Setup 

 

 Select the MC-profile.txt file by clicking the folder icon placed at top right hand side and 
leave the rest as default 

 

 Now go to output tab of RoadCalc and select Station and Coordinates 
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 Make sure for both Alignment and profile centerline is selected 

 Enter 25.0 at Station interval 

 Toggled on include Curve Stations only 

 Click Clear List and After that click Calculate 

 

 Finally, to export the data into the note pad file we have previously saved click the 
printer Station icon 

 Open the note pad file and view the output file. Utilizing this file, you can design the 
canal using the canal design template. 
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 DRAFTING CAD GRAPHICS 2.4

Drafting one of eagle point package that provides access to Eagle Point Dynamic Annotation and 

associates text with objects. With this attachment, objects may be modified and the associated text 

is automatically updated to match the modified object. In this section you will cover Annotate 

alignment stationing and Draw a coordinate grid. 

 Annotate alignment stationing 2.4.1

 In eagle point, select Drafting 

 

 Click Annotate and select Alignment Stationing 

 

 Click on the Pick in CAD icon to select the Main Canal 

 

 The Begin and End Station Range is filled in with the starting and ending stations 
automatically 

 

 Click on Apply to annotate the alignment stationing 

 The result should look like this 
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 Draw a coordinate grid 2.4.2

The Insert Coordinate Grid command allows you to place ticks, lines or both ticks and lines into 

your CAD graphic at a specified interval. 
To insert a coordinate grid into your CAD graphic, complete the following steps: 

 Click Insert tab and select Coordinate Grid 

 

 Select Placement options as Ticks & Lines from drop list 

 

 Northing (Y) interval =100 

 Lable Interval =100 

 Easting (X) interval =100 
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 Lable Interval =100 

 Leave the rest as default  

 Click on the Insert button to insert the coordinate grid 

 Graphically select the location for the lower left corner of the coordinate grid 

 Graphically select the location for the upper right corner of the coordinate grid 

 The result should look like this 

 

 Insert north arrow 2.4.3

The Insert North Arrow command allows you to place a North arrow into your CAD graphic. 

 Click Insert tab and North Arrow 

 Enter the scale factor for the North arrow =5 

 Click on the Insert button to insert the North arrow 

 Drafting prompts you to select a location for the North arrow. 

 Graphically select the location at which you want the North Arrow placed 

 

You are done!!! 
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 MANNUAL FOR HEC-RAS 3

 BASIC KNOWLEDGE OF HEC-RAS 3.1

 The Hec-Ras software suite 3.1.1

The Hydrologic Engineering Center River Analysis System (HEC-RAS) is intended for calculating 

water surface profiles for steady gradually varied flow in nature or man-made channels. 

HEC-RAS is an integrated system of software, designed for interactive use in a multi-tasking, 

multi-user network environment. The system is comprised of a graphical user interface (GUI), 

separate hydraulic analysis components, data storage and management capabilities, graphics and 

reporting facilities. 

The HEC-RAS system ultimately contain three one-dimensional hydraulic analysis components 

for: (1) steady flow water surface profile computations; (2) unsteady flow simulation; and (3) 

movable boundary sediment transport computations. 

 Purpose 3.1.2

HEC-RAS is application software that is used to model almost any Hydraulic model problem 

including:  

 River Hydraulic Analysis and its inline structures 

 Storage areas 

 Irrigation Canals and its Structures 

 Time series and elevation controlled gates 

 Unsteady floodway analyses 

 Dam break analyses and levee breaching  

 Pump stations and navigation dams  

 Sediment transport capacity 

Other Advantage of HEC-RAS 

 Useful tables, graphs, and cross-section and profile plots for viewing results 

 Animation of simulations 

 Detailed Investigations and alternative evaluations 

 Design Studies 

 Real-time forecasting 

 Scope 3.1.3

This guideline covers the basic procedures for Diversion weir, Irrigation canal and selected 

Irrigation canal structures Modeling (Case study of Petu SSI Project). 

 Computer requirements 3.1.4

Pentium III with Microsoft, Windows XP, Vista or Windows 7, (recommended: Intel dual-core 

processor with 1GB of RAM), 1024x768 display (recommended: 1280x1024 or higher). 
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 CASE STUDY FOR PETU DIVERSION WEIR MODELING 3.2

 Preparation of working environment 3.2.1

This practical exercise will help how to model diversion weir using head work for Petu SSIP. 

 Getting started 3.2.2

Defining a project 

 Find the HEC-RAS folder in the Start Menu and click on HEC-RAS to start the program 

 

 Select New Project from the File pull down menu in the main HEC-RAS window 

 

 

 Select a drive, and select a path by double clicking in the directory box of the New 
Project window. For this example, double click on the data subdirectory for c:\Petu 
Diversion Weir folder\ Enter a title Petu Diversion Weir and the filename is Petu 
Diversion Weir.prj Click OK  

 

 

 

 The English System of units is the default. To use the Metric System, select Unit 
System from the Options pull down menu in the main HEC-RAS window to change from 
the English System to the Metric System. 
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 Incorporation cross sectional data 3.2.3

 Select Geometric data from the Edit pull down menu in the main HEC-RAS window 

 

 In the Geometric Data window, click on the River Reach tool with the mouse and draw 
the following river schematic by clicking the left mouse button and dragging the reach in 
the direction of the flow.  

 

 Double-click the mouse to end the reach. Give each reach a name Petu-Shashaf River.  

 

 Click on the Cross Section tool on the left side of the Geometric Data window 
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 Select Add a new Cross Section from the Options pull down menu in the Cross Section 
Data window and enter the river station label. HEC-RAS requires that river cross-
sections be entered starting upstream using the highest number as a "river station" label 
and proceeding downstream in the direction of flow 

 

 

 Enter data provided below for the Upstream reach (Reach 5) 

 Downstream reach length = 100  

 Manning’s Value = 0.035 

 Main channel reach station, Left bank =0.00 and Right Bank = 56.38 

 Contraction coefficients = 0.1 and Expansion coefficients =0.3 

Reach = 5 D/S Reach length=100 

U/S Weir Axis 

Station Elevation 

0.00 1434.482 

5.00 1434.312 

6.00 1434.237 

11.01 1434.100 

13.01 1433.796 

18.01 1433.359 

21.01 1433.196 

24.20 1432.882 

28.20 1432.874 

29.26 1433.034 

34.26 1433.839 

36.59 1434.885 

42.59 1435.876 

47.59 1437.896 

54.59 1439.877 

56.38 1440.479 



National Guidelines for Small Scale Irrigation Development MOA 

SSIGL 21:  Selected Application Software’s 33 

 

 

 Subsequent station lengths are all measured from the first station. Enter the 
corresponding elevations for each station. 

 The last station is on the right of the river valley, above the main channel and flow area. 

 Click on Apply Data to accept entry for this cross-section.  

 Select Plot Cross Section from the Plot pull down menu to visually check cross-section 
for errors. 

 

 

 

 Repeat the above Steps until all river stations for the reach (from reach-4 up to reach-1) 
are entered (Data provided in excel sheet provided). Then, change the Reach using the 
Reach pull-down menu and enter data for the rest of the reaches. Press the apply data 
button after each cross section is entered.  

 After all the cross section data is entered, select Exit Cross Section Editor from the Exit 
pull down menu in the Cross Section Data window 

 Your main geometry menu should now look like this 
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 Incorporating weir into a HEC-RAS analysis 3.2.4

Hec-Ras requires two cross section u/s and d/s of weir structure located at reach-4, to do so 

 Click tools in geometric data and select XS interpolation 

 

 Click in interpolation and for max distance between XS’s insert 20 

 In Reach drop down menu select All Reach 

 Click interpolate Xs’s 
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 Click Tables in geometric data and select Manning’s n or K value 

 

 

 Click and select tabs n#1, n#2 and n#3 

 

 

 Click Set Values and insert value = 0.035  

 

 Click Ok and make sure all cross sections have manning’s value entered  

 

 Your main geometry menu should now look like this 
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 Click inline structure located at the left side of toolbar 

 File menu select save as and give it a name Petu Dw 

 

 

 Right click and select zoom to the area around reach 4 

 Click option menu and select add inline structure 

 

 Enter value of 4.1 (in which the Weir is located) for the dialogue “enter new river station 
for inline structure 
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 Click ok and its ready to enter the weir structure 

 

 Salient features of the weir to be incorporated in HEC-RAS 

 

 Weir Crest Level = 1433.975 m 
 Weir Height = 1.5m 
 Effective length of Weir = 6.6m 
 Two under sluices = 0.70m  
 Two piers = 0.5m  
 Top width of the weir = 1.0 to 1.8 m 
 Downstream apron length, L of 12m 

 

Click Weir/embankment tool bar and insert values for the respective fields 

 Distance = 2, Width =1.8, Weir coefficient =1.7 
 For weir & under sluice section insert the table provided below 

Station Elevation 

14.21 1433.975 

21.16 1433.975 

21.16 1432.475 

21.86 1432.475 

21.86 1433.975 

23.85 1433.975 

28.45 1433.975 

30.02 1433.975 

30.80 1433.975 

30.80 1432.475 

31.50 1432.475 

31.50 1433.975 

34.20 1433.975 
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 Click Ok and Exit 

 

 Select cross-section 4.2 while in the Cross Section Data window. Choose Ineffective 
Flow Areas from the Options pull down menu. 

 Enter the stations and elevations from Table below in the Ineffective Flow Areas window 
that represent the blockage in the river channel due to the Weir abutments. Press OK  

 

Station 21.16 31.5 

Elevation 1436.073 1436.073 
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 Click on the Gate button in the inline structure data and insert the values provided below 

 Height = 0.7 
 Width = 0.7 
 Invert = 1432.94 
 Stations = 21.51 

          = 31.15 

 Orifice Coefficient = 0.8 
 Sluice Coefficient = 0.6 
 Weir Coefficient = 1.7 

 

 Choose Exit from the File pull down menu of the inline structure data Editor window. 

 Choose Exit Geometry Data Editor from the File pull down menu of the Geometric Data 
Window. 

 Save the project.  

 In the main HEC-RAS window, select Steady Flow Data from the Edit pull down menu to 
enter flow and boundary conditions.  

 

 

 Enter a 2 in the "Number of profiles to be calculated" input for the two profiles modeled. 

 Enter the flow at the farthest upstream station of each reach for each profile to be 
modeled. Once a flow value is entered at the upstream end of a reach, it is assumed 
that the flow remains constant until another flow value is encountered. For PF-1 insert 
flow = 24.84 and for PF-2 insert flow = 29.52 at station 5, which is 50 and 100 Year 
return period flood.  
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 Click on the Reach Boundary Conditions button to enter the steady flow boundary 
conditions window. Since we are computing multiple water surface profiles, click on Set 
Boundary for all profiles.  

 

 For mixed flow, flow which has both super and subcritical sections, select both an 
upstream and downstream boundary condition. A mixed flow regime is anticipated, 
therefore, all upstream and downstream boundary conditions are required.  

 For Down Stream select Normal Depth = 0.04, and choose Known W.S. UP Stream The 
known W.S. elevations are determined from a downstream weir.(Refer Petu Design 
Report) 

  Flow Known Water Surface Elevation 

Profile-1 24.84 1433.42 

Profile-2 29.52 1433.53 

 

 



National Guidelines for Small Scale Irrigation Development MOA 

SSIGL 21:  Selected Application Software’s 41 

 Select Ok and Exit boundary condition to return to Steady Data Flow window  

 Select Gate opening from option pull down menu  

 

 

 Insert 0.7 for # open Ht and 1 for #open then click ok 

 

 Select Exit Flow Data editor from the File pull down menu of the Steady Data Flow 
window to return to main HEC-RAS window. 

 Select Save Project from the File pull down menu in the main HEC-RAS window to save 
all geometric and flow data. 

 Select Steady Flow Analysis from the Simulate pull down menu of the main HEC-RAS 
window. Choose Mixed Flow Regime. 

 

 Select Critical Depth Output Option from the Options pull down menu of the Steady Flow 
Analysis window. Choose Critical Always Calculated, and press OK 

 
 

 Press Compute in the Steady Flow Analysis window to begin the HEC-RAS analysis.  

 When the following screens are visible the simulation has been run 
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 Let’s look at the characteristics of the bank full flow. Click on the tables tab of the main 
menu interface. Select options/profiles to view the results 

 

 

 
 

 This table provides water surface elevation, velocity, Froude number, area, width, 
energy grade line etc. Many more options are available under options/define table. 

 we can go back to the main menu and the plot profile tab to examine the flow profile 
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 CASE STUDY FOR PETU IRRIGATION CANAL & DROP STRUCTURES 3.3

 Preparation of working environment 3.3.1

This practical exercise will help how to model Irrigation canal and Drop Structures  

 Getting started 3.3.2

Defining a project 

 Find the HEC-RAS folder in the Start Menu and click on HEC-RAS to start the program 

 

 Select New Project from the File pull down menu in the main HEC-RAS window 

 

 

 Select a drive, and select a path by double clicking in the directory box of the New 
Project window. For this example, double click on the data subdirectory for c:\Petu 
Diversion Weir folder\ Enter a title Petu Canal and Drop Structure and the filename is 
Petu Canal and Drop Structure. prj Click OK  

 

 

 The English System of units is the default. To use the Metric System, select Unit 
System from the Options pull down menu in the main HEC-RAS window to change from 
the English System to the Metric System. 
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 Incorporation cross sectional data 3.3.3

 Select Geometric data from the Edit pull down menu in the main HEC-RAS window 

 

 In the Geometric Data window, click on the River Reach tool with the mouse and draw 
the following river schematic by clicking the left mouse button and dragging the reach in 
the direction of the flow.  

 

 Double-click the mouse to end the reach. Give each reach a name RSC-1 Canal.  

 

 Click on the Cross Section tool on the left side of the Geometric Data window 
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 Select Add a new Cross Section from the Options pull down menu in the Cross Section 
Data window and enter the river station label. HEC-RAS requires that canal cross-
sections be entered starting upstream using the highest number as a "river station" label 
and proceeding downstream in the direction of flow 

  

 Enter data provided below for the Upstream reach (Reach 31.212) 

 Downstream reach length = 3 

 Manning’s Value = 0.014 

 Main channel reach station, Left bank =0.00 and Right Bank = 0.2 

 Contraction coefficients = 0.1 and Expansion coefficients =0.3 

Station 31.212 
 

28.212 
 

21.212 
 

11.212 
 

1.212 
 

0 

Distance to D/S 3 
 

7 
 

10 
 

10 
 

1.212 
 

0 

0 1432.765 0 1432.315 0 1429.765 0 1426.765 0 1423.765 0 1423.583 

0 1432.415 0 1431.965 0 1429.415 0 1426.415 0 1423.415 0 1423.233 

0.2 1432.415 0.2 1431.965 0.2 1429.415 0.2 1426.415 0.2 1423.415 0.2 1423.233 

0.2 1432.765 0.2 1432.315 0.2 1429.765 0.2 1426.765 0.2 1423.765 0.2 1423.583 
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 Repeat the above Steps until all canal stations for the reach (from reach-28.212 up to 
reach-0) are entered. Then, change the Reach using the Reach pull-down menu and 
enter data for the rest of the reaches. Press the apply data button after each cross 
section is entered.  

 After all the cross section data is entered, select Exit Cross Section Editor from the Exit 
pull down menu in the Cross Section Data window 

 Your main geometry menu should now look like this 

 

 Incorporating drop into a HEC-RAS analysis 3.3.4

Hec-Ras requires two cross section u/s and d/s of Drop structure located at reach- 28.212, 21.212 

and 11.212 to do so 

 In order to insert Drop Structures the cross section should be adjusted as follows 

 Click cross section tab 

 Select cross section at station 28.212 

 From option drop down menu select copy current cross section 

 Enter 28.21 at river station  
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 Since the values are inherited from the u/s cross section i.e the drop height is 1.5 and 
subtract from elevation values as given in the table  

 Change D/s reach length for station 28.212 = 0.002 and for copied cross section leave it 
as it is. 

Station 
New Cross  

Section 

D/s Reach 

Length 

CBL U/S  

of Drop 

CBL D/S 

 of Drop 

TBL U/S of 

Drop 

TBL D/S of 

Drop 

28.212 28.21 0.002 1431.965 1430.465 1432.315 1430.815 

21.212 21.21 0.002 1429.415 1427.915 1429.765 1428.265 

11.212 11.21 0.002 1426.415 1424.915 1426.765 1425.265 

 

 Repeat the same steps for stations 21.212 and 11.212 as station 28.212. 

 Your Canal profile plot should now look like this 

 

 Click tools in geometric data and select XS interpolation 

 Click in interpolation and for max distance between XS’s insert 2 

 In Reach drop down menu select All Reach 

 Click interpolate Xs’s 

 Click Tables in geometric data and select Manning’s n or K value 
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 Click and select tabs n#1, n#2 and n#3 

 Click Set Values and insert value = 0.014 

 Click Ok and make sure all cross sections have manning’s value entered  

 Your main geometry menu should now look like this 

 

 Choose Exit Geometry Data Editor from the File pull down menu of the Geometric Data 
Window. 

 Save the project.  

 In the main HEC-RAS window, select Steady Flow Data from the Edit pull down menu to 
enter flow and boundary conditions.  

 Enter a 1 in the "Number of profiles to be calculated" input for the two profiles modeled. 

 Enter the flow at the farthest upstream station of each reach for each profile to be 
modeled. Once a flow value is entered at the upstream end of a reach. For PF-1 insert 
flow = 0.046 at station 31.212, which is the designed discharge.  

 

 Click on the Reach Boundary Conditions button to enter the steady flow boundary 
conditions window.  

 For Canal modeling the flow is assumed to be steady and uniform, thus the flow which 
will have subcritical sections, select downstream boundary condition.  

 For Down Stream select Normal Depth = 0.15. (Refer Petu Design Report) 
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 Select Ok and Exit boundary condition to return to Steady Data Flow window 

 Select Exit Flow Data editor from the File pull down menu of the Steady Data Flow 
window to return to main HEC-RAS window. 

 Select Save Project from the File pull down menu in the main HEC-RAS window to save 
all geometric and flow data. 

 Select Steady Flow Analysis from the Simulate pull down menu of the main HEC-RAS 
window. Choose Subcritical Flow Regime. 

 

 Select Critical Depth Output Option from the Options pull down menu of the Steady 
Flow Analysis window. Choose Critical Always Calculated, and press OK 

 

 

 Press Compute in the Steady Flow Analysis window to begin the HEC-RAS analysis.  

 When the following screens are visible the simulation has been run 

 Click on the tables tab of the main menu interface. Select options/profiles to view the 
results 
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 This table provides water surface elevation, velocity, Froude number, area, width, 
energy grade line etc. Many more options are available under options/define table. 

 we can go back to the main menu and the plot profile tab to examine the flow profile 

  

 

 On the main menu click view 3D multiple cross section tab to visualize the canal flow in 
three-dimension perspective. 
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 On the main menu click view cross section tab   

 

 

         You are done!!! 
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 MANNUAL FOR Z-PROFILE, L-SEC 4

 BASIC KNOWLEDGE OF Z-PROFILE AND L-SEC 4.1

 The Z-profile & L-sec software suite 4.1.1

Z-Profile is an Auto-LISP and L-Sec is a VB.net routines routine to facilitate the generation of 

profile drawings from data prepared in Excel spreadsheets. It has been tested for compatibility with 

AutoCAD and IntelliCAD. to meet the needs of irrigation and drainage projects, for which large 

numbers of profile drawings are required. 

 Purpose 4.1.2

Both Z-Profile and L-Sec are application software’s that are used to prepare profile drawing 

including:  

 Irrigation and Drainage Canals Profiles 

 Sprinkler and Drip Main and Sub Main Profiles 

 Water supply Delivery and distribution profiles 

 Road Profiles 

 Scope 4.1.3

This guideline covers the basic procedures for Diversion weir, Irrigation canal and selected 

Irrigation canal structures (Case study of Petu SSI Project). 

 Computer requirements 4.1.4

Pentium III with Microsoft, Windows XP, Vista or Windows 7, 1024x768 display or higher 

 CASE STUDY FOR PETU CANAL PROFILE PREPARATION 4.2

 Preparation of working environment 4.2.1

This practical exercise will help how to prepare Irrigation and drainage canal profile drawing 

preparation for Petu SSIP. 

 Getting started for Z-Profiles 4.2.2

Installation 

For AutoCAD users, copy Zprofile.dcl and Zprofile.lsp into the C:\Program Files (x86)\AutoCAD 

\support directory.  

 

Data preparation 

Z-Profile will handle up to 9 sets of data. The first column contains the X-axis (chainage/ station) 

data. The other columns contain level data. A typical calculation spreadsheet is shown in Figure 

below.  
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Zprofile can handle blank data in any of the columns, i.e. there does not need to be a complete set 

of data for each chainage. 

 
The data have to be input as a fixed format text file containing  

I. The data title (as required on the drawing) for each column;   

II. Each data column 9 characters wide. 

The process to create this file from an Excel spreadsheet is 

 Select the visible columns and change the width to 10 (Format > Column > Width)  

 Insert rows for the data column headings and type in the headings in the first visible 
column  
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 Note: Each Columns should be filled as indicated below 

 Column A = Chainage Data 
 Column B = Original Ground Data 
 Column C = Canal Bed Level Data 
 Column D = Full Supply Level Data 
 Column E = Top Bank Level Data 
 Column F = Cut Depth Data 
 Column G = Fill Depth Data 
 Remember the file name, location and number of columns of data 
 Recommended data range is 50 

 Save the file as Formatted Text (space delaminated). This will receive a. prn suffix by 
default.  

 

 Plotting a long section with Z-Profile 4.2.3

 Open the AutoCAD program and from the Tools menu select Load application  
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 Type Zprofile.lsp in the file name and press Load  

 

 Type Zprofile to run the program press Enter 

 

 

 Select the data file and press Open  

 

 Enter 7 as number of columns and press Enter 

 

 Zprofile then loads the data and presents a dialogue box with suggested default values 
for the scales or it can be adjusted as required. 
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 Zprofile will then draw the profile  

 

 

 The profile will then need to be edited to suit the needs of the project 

 Getting started for L-Sec 4.2.4

Installation 

 For AutoCAD users, copy FORMAY-ICT and STRLSEC-ICT into the C:\ directory.  

 

 

 Copy and paste STRLSECBK-ICT.exe from STRLSECBK-ICT folder on the desktop 
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 Similarly Copy and paste PERFORMA-LSEC.xls from L-sec folder on the desktop 

 

 Now you are ready to prepare data to prepare profile drawing 

 

L-Sec will handle up to 7 sets of data. It is important to recall the columns are assigned to specific 

data. A typical L-Sec spreadsheet is shown in Figure below.  

 

 

 

Brief Description Items in Performa spread Sheet 

 REACH # = is a column in which Reach number is entered (R-1, R-2…) 

 CH = is a column in which Chainage or Station data is entered (0,20,40…)  

 NSL = is a column in which Original ground data is entered (1432,1433,1425….)  
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 DROP Ht = is a column in which Fall/Head loss data is entered (0.5,1,1.5….) 

 CBL = is a column in which Designed Canal Bed Level data is entered 
(1430.5,1430.2,1430.1….) 

 FSL = is a column in which Designed Full Supply Level data is entered 
(1431.0,1430.7,1430.6….) 

 TBL = is a column in which Designed Top Bank Level data is entered 
(1431.0,1430.7,1430.6….) 

 CUT = is a column in which Cut depth data is entered (0.2,0.85,0.45….) 

 FILL = is a column in which Fill height data is entered (0.5,0.75,0.55….) 

 FSD = is a column in which Full Supply Depth data is entered (0.5,0.4,0.35….) 

 FB = is a column in which Free Board data is entered (0.3,0.25,0.15….) 

 SLOPE = is a column in which Longitudinal Slope data is entered (500,400,150….) 

 CHAINAGE = is a raw in which Station at the Reach location is entered (0,20,40…) 

 DISCHARGE = is a raw in which discharge at the respective Reach is entered 
(0.4,0.6,0.2…) 

 LOSSES = is a raw in which Head loss at the respective Reach is entered 
(0.1,0.15,0.2…) 

 DEPTH = is a raw in which Full Supply Depth at the respective Reach is entered 
(0.1,0.2,0.3…) 

 WIDTH = is a raw in which Canal bed width at the respective Reach is entered 
(0.1,0.2,0.3…) 

 FREE BOARD = is a raw in which Free Board at the respective Reach is entered 
(0.1,0.2,0.3…) 

 BED SLOPE = is a raw in which Free Board at the respective Reach is entered 
(500,400,150….) 

 SIDE SLOPE = is a raw in which Side Slope at the respective Reach is entered 
(1,1.5,2….) 

 VELOCITY = is a raw in which velocity at the respective Reach is entered 
(0.6,0.5,0.9….) 

 CVR = is a raw in which Critical Velocity Ratio at the respective Reach is entered 
(0.9,0.95,1….) 

 BANKWIDTH = is a raw in which Bank width at the respective Reach is entered 
(0.5,1,1.5….) 

 VALUE OF "N" = is a raw in which Manning’s value at the respective Reach is entered 
(0.025….) 

 W. ALLOWANCE = is a raw in which Canal Duty at the respective Reach is entered 
(1.2,1.5….) 

 NAME OF CANAL = is a raw in which the name of a canal is entered (LMC-1, RMC-
1….) 

 O/T CHAINAGE = is a raw in which Off taking canal Chainage is entered (0,20,40…) 

 FSL IN CANAL = is a raw in which Full Supply Level of parent canal is entered 
(1431.0,1430.7,1430.6….) 

 FSL IN O/T CANAL = is a raw in which Full Supply Level of off taking canal is entered  

 WH = is a raw in which working head is entered 

 GCA = is a raw in which Gross command area is entered at the respective Reach is 
entered (40,25….) 

 CCA = is a raw in which Cultivable command area is entered at the respective Reach is 
entered (40,25….) 

 Type of structure = is a column in which the name of structure at the respective reach is 
entered (Drop, TO…) 
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Data preparation 

 For this exercise RSC-4 canal from Petu SSIP is selected 

 Salient Features of RSC-4 (Refer Petu SSIP Design report) 

 Number of Reach = 1 
 CCA = 5.165 
 Manning’s n =0.018 

 At REACH # cell: A5 enter R-1 since it has only one reach 

 Copy and Paste Cum.Dis (m) data from RSC-1.xls to CH column of PERFORMA.xls 

 Copy and Paste OGL (m) data from RSC-1.xls to NSL column of PERFORMA.xls  

 Drop structures exist at chainage 5, 20, 40, 60, 80, 100 and 120 with drop height of 1-
2.5 m and enter the drop height at column of DROP Ht of PERFORMA.xls with 
corresponding chainage 

 

 In similar pattern for DATA and DETAIL columns enter the corresponding data values  

 CHAINAGE = 0 (beginning of the reach) 
 DISCHARGE = 0.029  
 LOSSES = 0 
 DEPTH = 0.210  
 WIDTH = 0.250  
 FREE BOARD = 0.250  
 BED SLOPE = 167 i.e. 1/0.006  
 SIDE SLOPE = 0 i.e. Vertical cross  
 VELOCITY = 0.79  
 CVR = 1 or enter allowable value for respective canal lining 
 BANKWIDTH = 0.5 
 VALUE OF "N" = 0.018 
 W. ALLOWANCE = 0.75 
 O/T CHAINAGE = 0 
 FSL IN CANAL = 1392.56 
 FSL IN O/T CANAL = 1392.41 
 WH = 0.15 
 GCA = 5.940 
 CCA = 5.165 
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 For STRUCTURE data column enter values from the table to the respective location  

Type of structure Distance FALL 

DROP-1 5.00 2.50 

DROP-2 20.00 2.50 

DROP-3 40.00 2.50 

DROP-4 60.00 2.50 

DROP-5 80.00 2.50 

DROP-6 100.00 2.50 

DROP-7 120.00 1.00 

 

 Now it is ready to continue the calculation and Plotting the Longitudinal section 
 N.B. L-sec program unlike Z-profile is designed for Horizontal scale =300 and Vertical scale 

=100, whenever we need to change the scale we have to do it manually. 

 Save the file in any location that is comfortable for you 
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 Plotting a long section with L-Sec 4.2.5

 Open Auto CAD window 

 Double click STRLSECBK-ICT.exe from desktop and the following window will popup 

 

 Click Calculation button and select the PERFORMA-LSEC.xls file in which previously 
prepared. 

 

 When automatic calculation completed it will fill, CBL, FSL…. As shown in the figure  
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 Click L-section button again select the PERFORMA-LSEC.xls file in which the 
calculation has already carried out. 

 N.B. don’t forget to open blank AutoCAD window 

 The initial Profile Drawing output should look like this and it needs manual editing i.e the 
scale and the fonts. 

 

 The Final Profile Drawing output after editing the fonts and scale (H=700, V=500) 
Should look like this. 

 

You are done!!!! 
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 MANNUAL FOR STABILITY ANALYSIS OF MICRO DAM 5

 BASIC KNOWLEDGE OF GEOSTUDIO 5.1

 The geo studio software suite 5.1.1

It includes the following software products: 

 SLOPE/W for slope stability analysis 

 SEEP/W for groundwater seepage analysis 

 SIGMA/W for stress and deformation analysis 

 QUAKE/W for dynamic earthquake analysis 

 TEMP/W for thermal analysis 

 CTRAN/W for contaminant transport analysis 

 AIR/W for air flow analysis 

 VADOSE/W for vadose zone and soil cover analysis 

 Purpose 5.1.2

Geo-Studio is application software that is used to model almost any geotechnical problem 

including:  

 Slope stability problems involving earth and rock slopes, including sloping Excavations, 
embankments, anchors, soil nails and geo-fabrics 

 Seepage affected by infiltration, drains, and injection wells  

 Deformation resulting from staged loading, excavations, and fill placement or removal 

 Earthquake-induced deformation and pore-water pressure generation  

 Contaminant transport problems 

 Thermal conduction and transient 

 Freeze-thaw problems 

 Unsaturated soil behavior and more… 

 Scope 5.1.3

This guideline covers the basic procedures for Stability analysis of Micro Dam (Case study of 

Shimburit Earth Dam). 

 Computer requirements 5.1.4

Pentium III with Microsoft, Windows XP, Vista or Windows 7, (recommended: Intel dual-core 

processor with 1GB of RAM), 1024x768 display (recommended: 1280x1024 or higher). 

 CASE STUDY FOR STABILITY ANALYSIS OF SHIMBURIT EARTH DAM 5.2

 Preparation of working environment 5.2.1

This practical exercise will help to obtain the minimum factor of safety and the critical surface 

profile 
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 Getting started 5.2.2

Defining a project 

 Creating a new SEEP/W project from the Start Page of GeoStudio 

 

 Click SEEP/W to start a new project 

 

 

 Write the name of analysis as SEEP/W, and description as Shimburit Micro Dam. 

 Analysis as: Steady-State Seepage Analysis and Description as SEEP/W Exercise 
 Adapt the default values for the rest 

 

Setting  

 Click set dialog box and select Page 
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 Click mm to set dimension in SI unit, Width 683mm and Height 300mm ,Click Ok 

 

 Click set dialog box and select Units and Scale 

 Choose SI Units for tick box 

 Set scale for both horizontal and vertical as 1:300 

 For Problem extents insert minimum X = -2.0873 and minimum Y= -5.08 the maximum 
extent computes automatically, Click ok 

 

 Click set dialog box and select Grid 

 Make the X:Y, aspect ratio 0.5:0.5, Tick both display grid and snap to grid and Close 
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 Your final working area should look like this. It is recommended to save your file 
frequently 

 
 

 Click set dialog box and select Axes  

 Tick Left Axes, Bottom Axes and Axis Number then Click ok 

 

 On Set Axis size dialogue insert 

 X axis Min =12, Increment Size = 2 and # of increment = 89 
 Y axis Min = 8, Increment Size = 1 and # of increment = 50 

 After Clicking ok Your final working area should look like this 
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 Defining the geometry 5.2.3

Before defining the geometry in SEEP/W, it is convenient to first sketch the problem. It is planned 

to analyze the stability of a homogenous dam (refer Shimburit Dam Drawing). 

 Dam height = 16.0 m 

 Free board = 2.3 m 

 Reservoir depth = 11m 

 Top width = 5.0m 

 U/s slope H:V = 3:1 and D/S slope H:V= 2:1 

 It is going to rest on 4m soil and then competent rock beyond. 

 

 

When creating the Shimburit model (Refer Drawing), first draw the geometry; create and assign 

materials, draw pore-water pressure conditions and draw the slip surface geometry, which will 

control the mode of failure you are going to analyze. The lines are considered as objects, which 

can be adjusted or deleted using the Modify: Objects command 

 

Drawing Geometry 

Start by drawing the geometry of Individual embankment dam regions. 

 Click Draw dialog box and select Region 



National Guidelines for Small Scale Irrigation Development MOA 

SSIGL 21:  Selected Application Software’s 70 

 

When you click the region command you will get cross hair that will be used for plotting the region. 

 
 
For this exercise there are six regions 

 Region 1: Embankment Material 

 Region 2: Filter Material (Fine Sand) 

 Region 3: Filter Material (Medium Sand and Gravel) 

 Region 4: Rock Toe Material 

 Region 5: Foundation Material 

 Region 6: Competent rock 

Region will be created by clicking the coordinates that will define the required geometry and Click 

the left mouse button to create region points. Once the polygon region has been closed, you can 

either continue to draw additional regions, or you can exit the draw regions mode. Move the cursor 

to the following coordinates respectively in clockwise direction. 

 

Regions Material Points 

Region 1 Foundation Material-1 1,2,3,4 

Region 2 Foundation Material-2 5,6,7,8 

Region 3 Filter Material-1- (Fine Sand) 9,3,4,10,11,12,13,14,15 

Region 4 
Filter Material-2- (Medium Sand 
and Gravel) 

13,16,17,18,19,20,15,14 

Region 5 Filter Material-3- (Fine Sand) 20,21,22,19 

Region 6 Closely Jointed Basalt Rock 7,23,24,25,26,18,19,22,21,20,15,9,3,2,27,28,5,8 
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Regions Material Points 

Region 7 Embankment Material 29,30,31,32,33,34,16,13,12,11,10,4,1,2,27,28,5,6,7,35 

Region 8 Rock Toe Material 17,16,34,18 

1) Foundation material-1 

 Draw region using X-Y values for Foundation Material-1 Staring from point 1 - point 4 

 Click left mouse and then click right mouse to finish Foundation Material-1 region 

 
X (m) Y (m) 

Point 1 112.3887 19.0198 

Point 2 112.1417 18.7870 

Point 3 124.6833 18.1180 

Point 4 124.6821 18.3899 

2) Foundation material-2 

 Draw region using X-Y values for Foundation Material-2 Staring from point 5 - point 8 

 Click left mouse and then click right mouse to finish Foundation Material-2 region 

 
X (m) Y (m) 

Point 5 101.8302 18.695443 

Point 6 101.4858 19.02025 

Point 7 50.0877 20.0200 

Point 8 50.0892 19.71985 

3) Filter material-1- (Fine Sand) 

 Draw region using X-Y values for Filter Material-1 Staring from point 9 - point 15 

 Click left mouse and then click right mouse to finish Filter Material-1 region 

 
X (m) Y (m) 

Point 9 124.6838 17.7507 

Point 3 124.6833 18.1180 

Point 4 124.6821 18.3899 

Point 10 124.6794 18.7459 

Point 11 138.1737 18.7430 

Point 12 139.9533 20.5016 

Point 13 140.1273 20.4128 

Point 14 137.4558 17.7514 

Point 15 137.4558 17.7365 

4) Filter material-2- (medium sand and gravel) 

 Draw region using X-Y values for Filter Material-2 Staring from point 13 - point 16 

 Click left mouse and then click right mouse to finish Filter Material-2 region 
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  X (m) Y (m) 
Point 13 140.1273 20.4128 
Point 16 140.4216 20.266 
Point 17 137.6864 17.5417 
Point 18 150.2709 17.5388 
Point 19 150.2719 17.3932 
Point 20 137.454 17.3896 
Point 15 137.455 17.7365 
Point 16 140.4216 20.266 

5) Filter material-3- (Fine sand) 

 Draw region using X-Y values for Filter Material-2 Staring from point 20 - point 19 

 Click left mouse and then click right mouse to finish Filter Material-3 region 

 

  X (m) Y (m) 

Point 20 137.454 17.3896 

Point 21 137.4527 17.1885 

Point 22 150.2814 17.1819 

Point 19 150.2719 17.3932 

6) Closely jointed basalt rock 

 Draw region using X-Y values for Basalt Rock Staring from point 7 - point 8 

 Click left mouse and then click right mouse to finish Basalt Rock region 

  X (m) Y (m) 

Point 7 50.0877 20.02 

Point 23 25.0877 20.07 

Point 24 25.1877 12.045 

Point 25 175.0794 12.045 

Point 26 175.2127 17.52 

Point 18 150.2709 17.5389 

Point 19 150.272 17.3932 

Point 22 150.2814 17.1819 

Point 21 137.4528 17.1885 

Point 20 137.454 17.3896 

Point 15 137.4558 17.7366 

Point 9 124.6838 17.7507 

Point 3 124.6833 18.118 

Point 2 112.1418 18.7871 

Point 27 108.8874 15.7198 

Point 28 104.9862 15.7195 

Point 5 101.8303 18.6954 

Point 8 50.0892 19.7199 

 

7) Embankment material 

 Draw region using X-Y values for Embankment material Staring from point 29 - point 35 

 Click left mouse and then click right mouse to finish Embankment material region 
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  X (m) Y (m) 

Point 29 80.3875 28.4706 

Point 30 104.5954 36.5198 

Point 31 109.5867 36.5196 

Point 32 125.2863 28.519 

Point 33 128.2866 28.5198 

Point 34 141.8844 21.7296 

Point 16 140.4216 20.266 

Point 13 140.1273 20.4129 

Point 12 139.9533 20.5017 

Point 11 138.1737 18.7431 

Point 10 124.6794 18.7459 

Point 4 124.6821 18.39 

Point 1 112.3887 19.0198 

Point 2 112.1418 18.7871 

Point 27 108.8874 15.7198 

Point 28 104.9862 15.7195 

Point 5 101.8303 18.6954 

Point 6 101.4858 19.0203 

Point 7 50.0877 20.02 

Point 35 77.3926 28.4695 

 

8) Rock toe material 

 Draw region using X-Y values for Rock Toe Material Staring from point 17 - point 18 

 Click left mouse and then click right mouse to finish Basalt Rock region 

 
X (m) Y (m) 

Point 17 137.6865 17.5417 

Point 16 140.4216 20.2660 

Point 34 141.8844 21.7296 

Point 18 150.2709 17.5389 

 Your final Drawing area should look like this.  
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 Creating materials 5.2.4

Materials are first created and then assigned to geometry objects.  

 

Creating material 

 Click on KEYIN and click Materials 

 

 For the first region add a new material, name it as Embankment Material 

 Material model from the drop down list as Saturated/Unsaturated 

 Hydraulic Property as default or none 

 

 For the rest of regions repeat the same step 
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Setting the hydraulic conductivity function 

For a steady-state analysis, only a conductivity function needs to be defined.  

The “dot-dot-dot” button is used extensively in GeoStudio to indicate that additional 

features can be accessed. Click on this button to create a hydraulic conductivity function.  

 

 

 Click on the “add” button, give the function a name as Embankment Conductivity and 
select the type from the dropdown list Data Point Function.  
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We are defining a data point function of Matric suction, which is a positive value, and a hydraulic 

conductivity. Often a 2-point function is sufficient as a starting point. Additional points can be 

added and adjusted by editing the function directly. It is also possible to insert the hydraulic 

function using the conductivity script function that will be given separately. 

 

 Click Matric Suction and conductivity box to insert the following 4 points for 
embankment conductivity 

 Hydraulic conductivity values for Fine Sand Material 

Matric Suction (kPa) Kx (m/s) 

2 1e-5 

6.86 2.50e-6 

36.98 2.72e-8 

100 1e-8 

 

 

Click the edit data points at the bottom and then the add points to edit the graph and insert 

additional points.  It is possible to adjust the graph by pulling the added points by clicking move 

points button. 

 

Once you are happy with your function, you can then close the KEYIN: Hydraulic conductivity 

dialogue box to be returned to the KEYIN: Materials Properties view. From the Hydraulic 

properties functions (Hydraulic Conductivity function) click the dropdown menu to change it into 

Embankment Conductivity. 
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 Click Matric Suction and conductivity box to insert the following 4 points for the rest of 
materials as given in a table. 

 

 Hydraulic conductivity values for Filter Material (Fine Sand) 

Matric Suction (kPa) Kx (m/s) 

2 0.0001 

6.2 3.69e-05 

20.81 5.12e-06 

100 1.00e-06 

 

 

 

 

 Hydraulic conductivity values for Filter Material (Medium Sand and Gravel) 

Matric Suction (kPa) Kx (m/s) 

2 0.001 

8.55 0.000313 

34.95 5.45e-05 

100 1.00e-05 

 Hydraulic conductivity values for Rock Toe Material 

Matric Suction (kPa) Kx (m/s) 

2 0.1 

5.61 0.064795 

19.24 0.021258 

100 0.01 
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 Hydraulic conductivity values for Foundation Material 

Matric Suction (kPa) Kx (m/s) 

2 1e-007 

5.80 2.3053445e-008 

22.32 8.5039671e-010 

100 1e-010 

 Hydraulic conductivity values for Closely Jointed Basalt Rock 

Matric Suction (kPa) Kx (m/s) 

2 1.00e-15 

6.31 4.99e-17 

24.28 2.52e-19 

100 1.00e-20 

Assigning the material to the region 

The function has now been assigned to the soil. The material can now be assigned to the 

geometry regions.   

 Choose Materials from the DRAW dropdown menu to assign the material properties 
(hydraulic function) to the embankment soil. Later on we will also follow the same 
procedure to assign the hydraulic function for the foundation soil.  

 Click Draw and select Material 

 

 Make sure the assign radio button on and Embankment material is selected 

 Move the cursor to Embankment region and left click 

 The embankment boundary colure will be changed  
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 Similarly move the cursor to filter, foundation, Basaltic rock and rock toe to assign 
materials in similar fashion 

 

 Fixing boundary condition 5.2.5

 Select Boundary Conditions from the DRAW menu  
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 Click KEYIN boundary conditions to assign a boundary for the reservoir 

 

 Click add button, add new hydraulic boundary condition, give name i.e. Full reservoir 
=35 m from river bed level and change the colour. Make sure that on the Type pull down 
menu to Head (H) and insert the reservoir depth i.e. 35 m in the action box 

 

 Applying boundary to the geometry 5.2.6

Zero pressure boundary 

 A zero pressure boundary condition will be applied to the filter toe, which is a geometry 
line. Make sure that the select line is clicked 
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Seepage face 

 A potential seepage face boundary condition will be applied to the downstream face, 
which is an edge. A potential seepage face is a special boundary condition that is used 
when you want the solver to locate the position of where a seepage face might develop.  

 Select the potential seepage face from drop down menu to fix it for the downstream. 
Make sure that line is selected and click the downstream face of the dam. 

 

 

Adding reservoir 

 To add the reservoir from sketch menu select polyline and draw the upstream reservoir 
level starting from coordinate (25, 35) to (100, 35). 

 Fix the boundary by selecting FRL = 35, and make sure that line is selected. Then click 
the upstream face of the dam. 
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Breaking a region 

 In order to locate the intersection point of the reservoir and upstream slope of the 
embankment you may zoom it and Click on draw points and locate exactly at the 
intersection the point. In this case point 35. 

 

 To break up a region edge so that you can apply the boundary condition, such as the 
reservoir total head to only a portion of the edge (i.e. excluding the free board), you may 
need to insert a region point.  

  

 Click draw boundary condition and select the reservoir boundary then click the remove 
icon somewhere the line below point 30 and 36. You will see a green boundary line for 
the upstream slope and the reservoir water boundary will end up to point 36. 
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Viewing the finite element 

 You can view the finite element mesh using DRAW: Mesh Properties. 

 

 Change Approximate Global element size as 1.5 m 

 
Determining flux section 

 One of the objectives of this analysis was to compute the amount of flow through the 
earth dam. To do this, we can use a flux section.  

 Click Draw and select flux section 

 Click OK button and draw the flux section at one point, you may select at the centre or 
axis of the dam 

 

 Now it’s time to solve the problem 
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 Solve and contour 5.2.7

Verify/optimize 

Before that you may review the data by clicking on View or Optimize icon 

 

Solve and contouring 

 The solver for SEEP/W can be launched by clicking on the “SOLVE” icon. Click the start 
button to activate the solver. 

 You can view the results directly by clicking on the CONTOUR icon in the analysis 
toolbar. By default, the CONTOUR results will include velocity vectors, the location of 
the zero pressure contour and total head contours. 

 The flux section results can be viewed by selecting flux labels from the DRAW Menu. 
Clicking on the flux section will make the total flux value appear 

 

Flow path 

 Flow paths represent the path that a drop of water would travel from the reservoir 
through the dam. Draw a flow path by using the appropriate pull down menu and then 
click the cursor anywhere within the profile 

Additional features that you may exercise by your self 

 Remember, at any time you can change the way the CONTOUR information is 
presented by using the View Preferences pull down menu.  

 You can also retrieve information from specific locations on the profile.  
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 Select VIEW: Result Information and then click on the location that you’re interested in. 
If you hold the CTRL key down, you can gather information from several different 
locations. 

 You can label your contours using DRAW: Contour Labels.  

 There are many different types of parameters you can contour. Use DRAW: Contours to 
view some different results. Three default contour options are available, but you can 
also add other options to the list using the Add button. 

 Reporting  5.2.8

New to GeoStudio 2007 is a reporting feature. If you need to generate a report of your input data, 

select Report from the VIEW menu. Once you save the report file, your default word processing 

program will open with a generated report. You can now insert pictures, apply style templates or 

add and delete data. 

 Adding a new analysis 5.2.9

GeoStudio 2007 has the ability to run many different analyses within the same project file. The 

geometry is considered project specific, but you can change boundary conditions, material 

properties or even different types of analyses. 

 Slope/W 5.2.10

 Use the SEEP/W computed pore-water pressures in a stability analysis using 
SLOPE/W.  

 Click on KEYIN and then analysis to use the results of SEEP/W analysis for SLOPE/W. 

 Click the add button to select the type of analysis and then Limit equilibrium. 

 

 You may give a name like slope stability analysis and description 

 Select Morgenstern-Price and ensure that a half-sine function is being applied in the 
settings dialog box.  
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 Under the pore-water pressure (PWP) option, select parent analysis 

 Under the slip surface tab, select Direction of movement left to right and Slip surface 
option as Entry and Exit 

 

 Assigning materials 5.2.11

Creating material data 

 Click on KEYIN and click Materials 
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 For the first region add a new material, name it and select a strength model from the 
drop down list. You can use the tab key to move between the edit boxes. You may put 
the name as Embankment Soil, Material model as Mohr-Coulomb and Basic material 
properties as. You may change the colour of the soil by clicking set and select color. 

 Unit weight= 16 KN/m3,  
 Cohesion = 29 kPa and  
 Phi =15o 

 To create a second material, you have choices; you can either add one, or you can 
clone the existing material and repeat similar steps 

 

 Basic material values for Filter Material (Fine Sand) 

 Unit weight= 18 KN/m3,  
 Cohesion = 0 kPa and  
 Phi =30o 

 Basic material values for Filter Material (Medium Sand and Gravel) 

 Unit weight= 20 KN/m3,  
 Cohesion = 0 kPa and  
 Phi =36o 

 Basic material values for Rock Toe Material 

 Unit weight= 17 KN/m3,  
 Cohesion = 0 kPa and  
 Phi =40o 

 Basic material values for Foundation Material 

 Unit weight= 17 KN/m3,  
 Cohesion = 29 kPa and  
 Phi =30o 

 Basic material values for Closely Jointed Basalt Rock 

 Unit weight= 20 KN/m3,  
 Cohesion = 0 kPa and  
 Phi =40o 
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Assigning materials to each region 

 Choose materials from the DRAW: dropdown menu 

 

 Drag the respective material and click on respective region. The color for the region can 
be done by dropdown menu from assign 

 

 Repeat the same procedure for the rest of the region 

 

 Click Draw and select Slip Surface then Entry & Exit 
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 Insert the following ranges for Entry range (left side) and Exit Range (Right side). This is 
for downstream slope analysis. But for upstream side the entry will right side and exit 
will be the left side. 

 

 Now the problem definition has been completed.  Congratulations!!!  

You can double check your input in different ways. For example:  

I. Select object information from the VIEW pull down menu. Click within any region to 

review the soil properties for that particular region.  

II. You can also view the information for any other geometric object. 

III. Another way to review your input parameters is to use the DRAW: Contours feature 

available within DEFINE.  

IV. You can contour various parameters such as soil properties and pore-water pressures. 

Notice that when you define a piezometric line in SLOPE/W, the software considers the 

pore-water pressures to be hydrostatic both below and above the piezometric line.  

V. You can also label the contours.  
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 Verifying the input data 5.2.12

 Choose Verify from the TOOLS drop down list and SLOPE/W will run a number of 
checks to see if there are any errors or warnings. 

 

 Solve and contour 5.2.13

 Click on the SOLVE icon found on the Current Analysis Toolbar. 

.  

 Select the start button to activate the solver. In the solver window you will see the 
computed factors of safety for each of the various methods 
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 Click the stat button to run the simulation. When the simulation is done correctly the 
status will be changed into Solved 

 

 You can review the results directly by clicking on the CONTOUR icon in the current 
analysis toolbar.  

 

 The critical slip surface appears along with the critical factor of safety 
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 Stability analysis at end of construction 5.2.14

GeoStudio 2007 has the ability to analyze stability at the end of construction within the same 

project file. The geometry is considered project specific, by changing only PWP to Ru.  

 Click window and select define 

 

 Click KeyIn and select Analyses 

 

 Click add and select Clone 

 

 Name it Stability analysis at end of construction 

 Select Ru from PWP drop down menu 
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 Click KeyIn and select pore water pressure 

 

 Insert 0.35 for embankment material and 0 for other materials then close 

 

 Using similar steps verify and solve 

 Click contour 
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 Stability analysis results 5.2.15

The summary of results of the stability analysis conducted for the different loading conditions 

presented and comparison of the computed minimum factor of safeties with that of the required 

factor of safeties are presented in Table. According to the result the dam is stable for the two 

loading conditions.  

 

 

You are done!!! 

 

Loading condition Recommended FoSmin Computed FoS 

End of construction 1.3 1.48 

Steady state seepage at normal level 1.5 1.62 
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 MANNUAL FOR MS-PROJECT 6

 BASIC KNOWLEDGE OF MS-PROJECT 6.1

 The MS-project software suite 6.1.1

Microsoft Project, the project management software program by Microsoft, is a very handy tool for 

project a manager that helps them develop a schedule, assign resources to tasks, track the 

progress, manage the budget, and analyze workloads for an ongoing project. 

 

Microsoft Project is a specialized database that stores and presents thousands of pieces of data 

related to your project. These pieces of information interrelate and affect each other in a multitude 

of ways. Under-lying this project database is the scheduling engine, which crunches the raw 

project data you enter and presents the calculated results to you. 

 

You can then manipulate and display this calculated data in various views to analyze the planning 

and progress of your project. This information helps you make decisions vital to the project’s 

success. 

 Purpose 6.1.2

Microsoft Project is application software that is used to aid most of Projects including:  

 Study and Design Projects 

 Construction projects so on… 

 Scope 6.1.3

This guideline covers the basic procedures of construction project planning for irrigation and head 

work (Case study of Didiga SSI Project). 

 Computer requirements 6.1.4

Pentium III with Microsoft, Windows 2000 and above, (recommended: Intel processor with 512 MB 

of RAM), 1024x768 display.  

 CASE STUDY FOR DIDIGA SSIP CONSTRUCTION SCHEDULING 6.2

 Preparation of working environment 6.2.1

This practical exercise will help how to prepare Construction Scheduling using for Didiga SSIP. 

 Defining project scope 6.2.2

To define the project scope and communicate it to other key stakeholders, you develop and record 

the scope statement. The scope statement should include the following: 

 Project justification 

 Product description 

 Project constraints or limitations 

 Project assumptions 

 Project deliverables 
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 Project objectives 

This Sample construction scheduling project is based on the assumption that: 

 Active involvement of the local community in the construction process 

 Utilize minimal use of Machinery 

 Construction activities starts from head work and proceed towards the irrigation system  

 Getting started 6.2.3

Creating a project file  

 Create a folder called Didiga SSIP anywhere you like 

 Start, All programs, Microsoft Office, Microsoft Project 2106 

 When you start Project, its Start screen appears 

 

 The Project Start screen includes options for creating a new plan or opening a plan 

 You create a new plan by clicking the Blank Project option on the Start screen. Doing so 
creates the new plan in the main Project interface 
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 Here are the major parts of the Project interface; note the label of the active view along 
the left edge 

 Let’s walk through the major parts of the Project interface 

 The Quick Access Toolbar is a customizable area of the interface where you can add 
your favorite or frequently used commands. 

 Use the Tell Me box to quickly find a Project command, or help about that command 
or feature 

 The ribbon contains the commands you use to perform actions in Project. 
 Groups are collections of related commands.  
 Commands are the specific features you use to perform actions in Project. 
 Zoom Slider: Simply zooms the active view in or out 

 File -> Options -> General tab -> Project view -> Default view then Select “Gantt with 
Timeline” from the dropdown box 

 

 File -> Options -> Display tab -> Show Indicators and Options Buttons for. Check all 
options 
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 File -> Options -> Schedule tab -> Schedule -> Show Assignment Units. Choose 
“Decimal” from the dropdown box 

 

 File -> Options -> Schedule tab -> Calculation -> Calculate Project after Each Edit. 
Check the On button 

 

 Options -> Save tab -> Save projects -> Save Files In this format. Select Project 
(*.mpp). file name as Didiga SSIP Construction schedule 
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Start Date 

 Click Project tab -> Properties Group -> Project Information.  

 A dialog box appears. In the start date box, type 11/11/15, or click the down arrow to 
display the calendar, select November 11, 2015.  

 Click OK to accept the start date. 

 

 Click Project tab -> Properties Group -> Project Information.  

 Click the arrow on the Calendar dropdown box. A list appears containing three base 
calendars and select a Standard Calendar as your project Calendar 

 

 

Setting Your Project Calendar 

 Click Project tab -> Properties Group -> Change Working Time 

 

 To change the working time of a particular day of each week, Select the workweeks field 

 Click Details 

 Select the day (Monday-Saturday) and Mark the “Set day(s) to these specific working 
time” 

 Click Ok 
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 Exceptions are used to modify a Project calendar to have a non-standard workday or a 
non-working day. 

 Calculating duration for activities 6.2.4

A duration of the task is the estimated amount of time it will take to complete a task. As a project 

manager you can estimate a task duration using expert judgment, historical information, analogous 

estimates or parametric estimate. Before undertaking any work or project it is necessary to know 

the time it will take to accomplish, which is obtained or derived by dividing the total quantity by 

acceptable Norms. For example,  

 Site Clearance for Camping site using four Daily Laborer 

 One Daily Laborer in 8 hr execute 10m2 
 Four crew each congaing four Daily Laborer in 8 hr. execute 160 m2 
 Total quantity for site clearance is 141 m2 
 Estimated time = 141/160 = 0.88 days  
 Therefor for total days for this activity is ~ 1 Day  

 The expected duration for the rest of the activities is calculated in similar fashion. For 
Didiga SSIP the duration is calculated and presented in File with the name of Norms 
Output and Resources.xls located in C-Excel file folder. 

 Scheduling tasks 6.2.5

 Tips 

 Brainstorming: Enter tasks as you think of them, without regard to sequence or 
grouping of related tasks. You can move and organize the tasks later. 

 Sequential: Think through the project from beginning to end, and enter tasks 
sequentially. 

 Phases: Think of the overall phases of the project. For example, 

After those phases are in place, you can add tasks and subtasks beneath them. 

 Milestones and deliverables: Consider what the project is producing in terms of the 
mile-stones and deliverables. Enter those events as tasks and then add tasks and 
subtasks beneath them to flesh out the project. Your scope statement can be a valuable 
guide in this process 
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Entering Tasks 

 From C-Excel file folder open Didiga Duration.xlsx file 

 Copy all activities and durations 

 In Gantt Chart View, just click a cell directly below the Task Name Column Paste it 

 

 In Gantt Chart View, just click a cell directly below the Start Column and select 
November 11/ 2015. 

 Similarly select the same day for all activities 

 

 Click the top left corner to select all the tasks 
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 Click the auto schedule tab 

 

 Then the task Mode will change to auto schedule mode 

Sub Tasks 

There can be a huge number of tasks in a project schedule, it is therefore a good idea to have a 

bunch of related tasks rolled up into a hierarchical chart view to help you organize the plan in a 

better way. It helps you organize your plan into phases. In MS Project, you can have several 

number of sub-tasks under any higher level task. 

 

 Mobilization and Access roads don’t have subtasks so leave them as it is  

 But Camping and camping facilities have number of sub task that needs to be rolled up 
to do so select task from 3.1 to 3.9.5 (refer the Norm,output and resources excel file)  

 

 Click Indent tab 
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 Again there are sub tasks of Fencing i.e. from 3.9.1 to 3.9.5 and likewise by clicking 
indent tab create the sub tasks 

 The created task hierarchy looks like this 

 

 

Creating Relationships between Tasks 

Once you have a list of tasks ready to accomplish your project objectives, you need to link them 

with their task relationships called dependencies. For example, Task “Access road” can start once 

Task “Mobilization” has finished. These dependencies are called Links.  

 

In MS Project, the first task is called a predecessor because it precedes tasks that depend on it. 

The following task is called the successor because it succeeds, or follows tasks on which it is 

dependent. Any task can be a predecessor for one or more successor tasks. Likewise, any task 

can be a successor to one or more predecessor tasks.  

 

There are only four types of task dependencies; here we present them with examples. 

 

 Finish to Start (FS): The finish date of the predecessor task determines the start date 
of the successor task. 

 Finish to Finish (FF): The finish date of the predecessor task determines the finish 
date of the successor task. 

 Start To Start (SS): The Start date of the predecessor task determines the start date of 
the successor task. 

 Start to Finish (SF): The Start date of the predecessor task determines the finish date 
of the successor task. 
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Link Task 

 In order to organize the tasks in specific order you have to understand the tasks 
relationships. Start with mobilization->Camping and facilities->Head work->Main canal… 

 In the predecessor tab of “access road” enter “1” (which is ID no. of Mobilization 
indicating that it comes after mobilization completed) 

 

 Under Camping and camping facilities the sub task “site clearance” can be started at the 
same time as “access road” activity starts hence enter “2SS” 

 

 The rest of the task linkage is self-explanatory 

 The final task schedule (Partially) will look like this 

 

 Create milestones 6.2.6

In Project Management, Milestones are specific points in a project timeline. They are used as 

major progress points to manage project success and stakeholder expectations. They are primarily 

used for review, inputs and budgets 
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Inserting a Milestone 

 Click Task name below mobilization 

 Click Task tab -> Insert group -> Click Milestone 

 

 MS Project names the new task as <New Milestone> with zero-day duration 

 Click on <New Milestone> to change its name to Milestone-1 

 Link it with “Mobilization” by entering “1” at the predecessor column of Mile stone 

 You can see the milestone appear with a rhombus symbol in the Gantt Chart View on 
the right. 

 

 Repeat the same procedures for all major tasks 

 

 Setting up resources in the project 6.2.7

In project management terminology, resources are required to carry out the project tasks. They 

can be people, equipment, facilities or funding required for the completion of a project task.  

 

Optimum resource scheduling is the key to successful project management. 
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Resource types  

 Work resources: People and equipment to complete the tasks.  

 Cost resources: Financial cost associated with a task.  

 Material resources: Consumables used as project proceeds.  

Adding resource names manually 

To add resources to your project by simple data entry, follow these steps: 

 Click View, Resource Sheet to switch to the Resource Sheet view 

 Make sure the Entry table is applied. Click View, Table, Entry 

 In the first Resource Name field, type the name of a resource and then press Enter 

 Enter the names of other resources in the same way 

 If a piece of equipment will be integral to the successful completion of a task, enter its 
name as a work resource, just as you would a human resource 

 On the Initials column enter the abbreviation against each resources 

 On the Max column enter the number of resources to be utilized 

 On the standard rate column enter the hourly cost against each resources 

 

Assigning resources to tasks 

 Click View Tab -> Split View group -> Details -> Task Form. 

 

 

 The window is split in two, Gantt Chart view and Task Form view below it. 

 In the Task Form view, click under the Resource Name column and select the resource. 

 Click the cell below the Resource Name column.  

 Select the resource from the dropdown list. 

 On the unit’s tab enter the expected input for that specific task. 
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 Repeat the same procedure for each task 

 During the process of assigning the resources will appear at the Gant chart and 
“Resources name” column 

 

View critical path 

Critical Path is the succession of connected tasks that will take the longest to complete. The word 

“critical” does not mean that the tasks are complex or important or need to be closely monitored, 

but the focus is on terms schedule that will affect the project finish date.  

 

So, if you want to shorten the duration of a project, you should first start with activities/tasks on the 

critical path. Critical path can be a single sequence of tasks (a single critical path) or there can be 

more than 1 critical paths for a single project. While schedule changes are made, it is also likely 

that the critical path will change from time to time.  
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One needs to always focus on the Critical Path first, when one wants to apply fast-tracking or 

crashing to shorten the project duration.  

 

Slack or Float are key to understanding Critical path. There are two types of Float:  

 

 Free Float: It is the amount of time a task can be delayed without delaying another task.  

 Total Float: It is the amount of time a task can be delayed without delaying the 
completion of the project.  

To View Critical path 

 In Gantt Chart view -> Format Tab -> Bar Styles Group -> Check the Critical Tasks box 
ON 

 

 All task bars in the critical path, in the Gantt Chart View on the right, will turn Red in 
color. 

 

Check resource allocations 

Relationship between a resource’s capacity and task assignments is called allocation. This can 

be defined by 3 states:  

 Under allocated: A skilled worker who works for 40 hours a week, has work assigned 
for only 20 hours.  

 Fully allocated: A skilled worker who works for 40 hours a week, is assigned 40 hours 
of work in that week. 

 Over allocated: A skilled worker is assigned 65 hours of work, when he only has a 

40-hour workweek.  
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 Click View Tab -> Task Views group -> Gantt Chart view. 

Gantt Chart View displays some limited resource information, as shown in the following 

screenshot. It summarizes whether there may be a problem by the red over allocated icon in the 

indicator column. 

 

 

 

The Resource Usage view displays resources and all tasks assigned to them underneath the 

Resource Name. The left-hand side of the screen lists the Resources and the Task Names 

together with columns of total information for the resource or assignment. The right-hand side 

shows a time-phased view. 

 

 Click View Tab -> Resource Views group -> Resource Usage view. 

 

Resolve Resource over Allocation 

One would need to either change the scope (reduce the amount of work), assign more resources, 

or accept a longer schedule to resolve over-allocation. 

 

This can be achieved by using some of the following techniques: 
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I. Adjust Schedule  

By changing its lead or lag time when the resource has more tasks assigned than can be 

completed during a given time period. If you add delay that is less than or equal to the amount of 

slack on the task, you will not affect the finish date of the project.  

 

By default, when you link tasks, they are assigned a “Finish to Start” relationship. In this 

relationship,  

 Lead: Lead time causes successor task to begin before its predecessor tasks ends.  

 Lag: Lag time causes successor task to start after its predecessor task ends.  

 Click Task Tab -> double-click the required Task under Task Name column -> Task 
Information dialog box opens -> Predecessors Tab 

 Under Lag heading column, enter the lag in terms of hours, days, weeks, or years. 

 

II. Substitute resources or add additional resources 

You can manually allot some other resource to the task. 

 Click View Tab -> Gantt Chart View -> Resource Name column.  

 Click the box below the Resource Name column for the task you need the resource to 
be assigned. 

 

Level Over-Allocated Resources 

If resources are over-allocated you can use resource-leveling feature in MS Project 2016. It works 

by either splitting tasks or by adding delay to tasks to ensure the resource is not overloaded. 

Leveling can delay the individual task finish dates and even the project finish date. Project does 

not change who is assigned to each task, total work, or assignment unit values. 
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Leveling  

Steps in the Leveling process are only a few, but it is important to understand what each option 

does. The steps are as follows: 

 Click Resource tab -> Level group -> Leveling Options. 

 

 

In Resource Leveling dialog box, under Resolving over allocations, leveling order dropdown box 

you can choose Standard. You have 3 options here:  

 ID only option delays tasks only according to their ID numbers. Numerically higher ID 
numbers (for example, 10) will be delayed before numerically lower ID numbers. You 
might want to use this option when your plan has no task relationships or constraints.  

 Standard option delays tasks according to predecessor relationships, start dates, task 
constraints, slack, priority, and IDs.  

 Priority, standard option looks at the task priority value before the other standard 
criteria (Task priority is a numeric ranking between 0 and 1000).  

In Resource Leveling dialog box, under Resolving over allocations, you have several options that 

you can select. These are explained as follows:  

 Level only within available slack. Selecting this checkbox would prevent Project from 
extending the plan’s finish date. MS Project will use only the free slack within the 
existing schedule, which could mean that resource over allocations might not be fully 
resolved.  

 Leveling can adjust individual assignments. Selecting this checkbox allows Project 
to add a leveling delay (or split work on assignments if Leveling Can Create Splits in 
Remaining Work is also selected) independently of any other resources assigned to the 
same task. This might cause resources to start and finish work on a task at different 
times.  

 Leveling can create splits in remaining work checkbox. This allows Project to split 
work on a task (or on an assignment if Leveling Can Adjust Individual Assignments on a 
Task is also selected) as a way of resolving over allocation.  

 Level manually scheduled tasks. Selecting this allows Project to level a manually 
scheduled task just as it would an automatically scheduled task.  
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 After the desirable adjustment click level all 

 Leveling will remove entire over-allocation 

 Resource before Leveling 

 

 Resource after Leveling 

 

Project Summary Task 

Project summary task is at the highest level of the plan’s outline; it includes rolled-up details from 

all subtasks. It also represents the full duration of the plan, so it’s a handy way of seeing some 

essential details, such as the plan’s overall duration. Project automatically generates the project 

summary task but does not display it by default.  

To display the project summary task 

 Click anywhere in a Gantt chart view. When the focus is on a Gantt chart view, the label 
of the Format tab is Gantt Chart Tools. 

 On the Format tab, select the Project Summary Task check box 

 

 

Project displays the project summary task at the top of the Gantt Chart view with an ID of 0. 
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 REPORTING PROJECT INFORMATION 6.3

 Setting up and printing views 6.3.1

To set up and print a view, follow these steps: 

 Open the view and arrange the data as you want it to appear when printed. 

 Click File, Page Setup to display the Page Setup dialog box. 

 Specify the options you want for the printed view using controls on the different tabs of 
this dialog box. You can adjust the view orientation, page scaling, margins, header and 
footer, and so on. When finished, click OK. 

 On the Standard toolbar, click Print Preview. A picture of the view as printed appears, 
reflecting your Page Setup options. 
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 Reporting project information 6.3.2

Generating reports: 

To see the list of available built-in reports: 

 Click Reports, Report. The Reports dialog box appears, showing the following 
categories.  

 

 

The report categories are as follows: 

 New Reports 

 Dashboards 

 Resources 

 Costs 

 In progress 

 Custom…. 

To select and print a report, follow these steps: 

 Click View, Reports. 

 In the Reports dialog box, double-click the category you want. 

 In the dialog box that appears, double-click the report you want. 

 If a dialog box prompts you for more information, such as a date range, enter it and then 
click OK. 

 The report appears in a Print Preview window 

 When ready to print the report, click Print on the Print Preview toolbar. 

 In the Print dialog box that appears, select the page range and number of copies you 
want to print and then click OK. 

 Here are some of report examples  
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 You are Done!!! 
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APPENDIX I: Worked Example & Model (Soft copy) 

 

 

APPENDIX II: Softwares (Soft copy)
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